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Symmetry User Documentation
Version 1.0

Introduction
Symmetry is an application which replicates the birth date, breed, and
Express Veriﬁed portions of the CCIA database by downloading new
changes every night. Applications which support Symmetry can then
communicate with Symmetry instead of the CCIA database allowing you
to use this information in real time.

Getting Started
When Symmetry is ﬁrst installed at your place, a current copy of the
database will be placed on your computer. Symmetry should be installed
on a computer that will always be on and that has access to the internet.
Normally this will be a server of some type. It can coexist with other applications on the server.
The ﬁrst time Symmetry is launched, the Preferences window will automatically open. You will need to change the preferences to suit your
situation and then start the APIs that you will be using in the Console
window. From then on there isn’t anything you need to do to keep Symmetry going unless it runs into errors and needs help.

Preferences
You can open the Preferences window by choosing the Preferences menu
item under the Edit menu on Windows or the application menu on OS
X. This window has a number of areas or panes which can be selected via
the list on the left hand side.
CCIA. This area is where you enter your CCIA account information. This is needed for Symmetry to download new information
from the CCIA database each
night. You can also determine the
time of night that this download
occurs if you want.
As is noted in the instructions on
this pane, you will need the BD
Replication WS and Breed Replication security options turned
on for your account. If this is not
already the case, you will need to
contact the CCIA to have them
do this.
There is also a button to allows
you to test your account. It is advisable to do this when you enter

your account information the ﬁrst time to make sure it is correct and
that the security options are turned on.
Error Logging. Because Symmetry normally runs in the background, it
can’t notify you of errors in the same way most applications do. Instead,
when an error occurs two or three things happen. First, a special sound
will play. Of course, this is only helpful if you are near enough to the
computer Symmetry is running on to hear it. At the same time, the error
is logged and can be viewed in the Console as explained later. Finally, you
can optionally ask Symmetry to email you when it encounters an error.
This is good idea, especially if you won’t be checking on it very often as
is normally the case.
This pane is the place where you enter your email account information
is you want Symmetry to send you an email when it encounters an error.
If you do not know this information, you can get it from your email provider. Please note that Symmetry does not support SSL email accounts.
A button is provided for testing your account information.
TCP API. If you have applications that will be communicating with
Symmetry via the TCP API, you will need to turn this API on in this
pane. You can also change the listening port and inactivity time out if
necessary.
Depending on how your ﬁrewall(s) are set up, you may need to open up
the port that Symmetry is listening on. If TCP traﬃc for that port cannot get to the machine that Symmetry is running on, Symmetry will not
be able to respond to any requests.
The inactivity time out tells
Symmetry how long to wait
before automatically closing a
connection with no traﬃc on it.
Normally the applications communicating with Symmetry will
close the connection when they
are ﬁnished making requests.
However, if something happens
where this is not possible, Symmetry will eventually close the
connection anyway to avoid
wasting resources.
Please note that turning the API
on or oﬀ in the preferences is
only changing the default state
of this API when Symmetry is
launched. If you want the API
to start or stop immediately, use
the Console window.
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File API.
Similar to the TCP API, you
can decide whether Symmetry
will use the File API and what
its options will be in this pane.
You select the folder that Symmetry will watch for requests in
as well as how often the folder
is scanned.
If you ask Symmetry to wait for
zero seconds between scans, it
will still wait for about one quarter of a second between scans.
If you need faster response than
this, you should consider using
the TCP API instead as it can
handle hundreds of requests per
second with no delay between
requests.
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have it update automatically.
You normally don’t need it to
auto refresh this information
unless you are testing for something. Auto refresh mode will
slow Symmetry down if the API
is handling multiple requests per
second.
For each connection you can see
the IP address of the connecting
computer, the date and time the
connection was made, the date
and time of the last request, and
the number of requests the connection has handled.
If you want to force a connection to close, you can select it
and click the Stop Selected Connections button.

As with the TCP API, turning this API on or oﬀ here is only aﬀecting
the default upon launch. Use the Console window to force it to start or
stop immediately.

File API Status. This area shows the status of the File API and allows
you to start and stop this API. If Symmetry is currently watching a folder, the folder being watched and how many requests have been handled
are shown.

Console Window

If you ask Symmetry to stop watching the folder while it is in the middle
of a scan, it will ﬁnish the scan before actually stopping.

The Console is Symmetry’s main window and is always opened upon
launch. If you close it, you can open it again by choosing Console from
the File menu.
There are ﬁve areas in this window and you can move between the areas
by clicking on the buttons near the top of the window. Underneath each
of these buttons is a status light. If everything in the area is okay, the
light will be green. If there is a problem that needs your attention, the
light will turn red. This makes it easy to verify that Symmetry is working
correctly at a glance. The two API status lights actually have three states
they can be in. If the API is on and working correctly, it will always be
green. However, if the API is not on, it’s color will depend on whether
the API is supposed to be on by default (as set in the preferences). If it
is supposed to be on, then it will be red signifying an error. If it isn’t supposed to be on, it will be yellow signifying that it isn’t running, but that
that is okay.
CCIA. This area is used to let you know if Symmetry’s database is up to
date with the CCIA’s database. Normally this will let you know that Symmetry is up to date and give you the date and time of the last download.
However, if it is not up to date, it will give you a message relative to this
and other information to help determine why it is not up to date.
TCP API Status. This area shows what is happening with the TCP
API. The top portion shows whether Symmetry is currently listening
with this API and, if so, what IP address and port it is listening on. You
can also start or stop Symmetry from listening. Note that if there are
live connections when you tell Symmetry to stop listening, this will not
aﬀect the live connections. It will only prevent new connections from
being made.
The bottom portion of this area shows the current connections being
handled by the API. You can click the Refresh button below the list to
have the list updated, or you can check the Auto Refresh checkbox to

Animals. Occasionally you may want to look up an RFID manually. This
area allows you to enter an RFID number in the search ﬁeld and see the
information Symmetry has for that number.
When you click the magnifying glass in the search ﬁeld, you can choose
how Symmetry will look for matches based on the RFID number you
enter. Leaving it as Is Exactly will always be the fastest search. The other
options can take several seconds to return any results.
Note that this area requires you to enter a normalized RFID number. For
example, if you have a tag number with the country code as letters in it,
the correct tag will not be found unless you enter the numeric equivalent
(ex. Canada’s code is CAN which equates to 124). This is only the case in
this area—the APIs normalize numbers automatically.
Clicking the little “x” in the search ﬁeld will clear the search and show
all the animals again.
Please note that Symmetry is only aware of RFID numbers that have had
a birth date, breed, or Express Veriﬁed status (http://www.expressveriﬁed.ca/) attached to them.
The list of animals shows the full RFID number as well as the birth
date, breed, and Express Veriﬁed status for each animal. In addition, the
date that each piece of information was submitted or last changed is also
shown.
Error Log. As explained earlier, when errors occur they are logged and
optionally emailed. Logged errors are shown here. When errors are ﬁrst
logged they will appear in the list in red. After you have reviewed the error and ﬁxed it, you should select it and click the Clear Selected Errors
button. Cleared errors appear in black if you have elected to show them.
Normally they do not show up at all.
Selecting an error shows the entire error message below the error list.
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Shutting Down Symmetry
During normal operation, Symmetry should always stay running. This
is especially important because Symmetry is only allowed to download
changes from the CCIA database at night and only for the last fourteen
days. Thus, if Symmetry does not run at night for that amount of time,
the database will not be up to date and you will need someone to come
and reinstall Symmetry on your machine again.
However, there are times when you need to temporarily shut Symmetry down for some reason. The safest way to do this is to ﬁrst stop any
APIs that are running. You can close the TCP API connections as well,
if necessary, although this may cause errors in the communicating applications.
At this point it is safe to choose Quit from the File menu (Windows) or
the application menu (OS X). As soon as possible, relaunch Symmetry
by double-clicking the Symmetry shortcut on the desktop (Windows) or
double-clicking the application itself (OS X).

The APIs
An API (application programming interface) is a way of allowing diﬀerent applications to work together. Symmetry has two APIs—TCP based
and File based—that other applications can use to ask Symmetry to give
them information about RFID tags. Symmetry’s job in this relationship
is to keep its data in sync with the CCIA database and to respond to
requests.
Any application (including multiple applications) can communicate with
Symmetry as long as it adheres to the API. Symmetry’s API is described
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in the “Symmetry API Reference” document which is available to anyone
who wants it. It is a very simple API and, other than the communication
layer, is exactly the same for both APIs.
The TCP API is based on network communications and is generally the
preferred API to use. However, the File API is based on the ﬁle system
and can be easier to use in some situations.
If you would like to make the necessary changes to your application to
communicate with Symmetry, feel free to contact us for more information.

Folder Structure
When Symmetry is installed on your computer, a folder named Symmetry will be placed in your user account’s documents folder. The actual
name of this folder varies depending on which of the supported operating systems you are using—Windows XP, Windows Vista, or Mac OS X.
Inside this folder there will be a Symmetry Application folder, a Symmetry Data folder, and, possibly, Symmetry Preferences and Symmetry
Log folders. It is important not to move or change any level of this folder
structure.
During an upgrade, you will normally download a zipped ﬁle which you
will need to unzip. On Windows you do this by right-clicking the ﬁle and
choosing Extract. On OS X, simply double-click the ﬁle. After unzipping you will be left with a folder called Symmetry. This folder needs to
be moved inside the Symmetry Application folder mentioned above to
replace the old folder. Only do this when Symmetry is not running.

